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[bookmark: _Toc159999865]Summary
The paper begins with an abstract of 800-1200 characters including spaces. The abstract should provide a synthetic description of the thesis and answer the following questions:
•	what was the research problem posed and solved in the paper? on which theoretical assumptions was the problem conception based?
•	what methods were used to solve the problem?
•	from which sources was the information used in the work drawn?
•	how was the problem-solving process carried out?
•	what conclusions are drawn from the research process?
The abstract headline is unnumbered, in 16-point bold, Times New Roman CE, and the space before and after the headline is 3 points. Set margins to 2.5 cm wide each, i.e.: left – 2.5 cm, right – 2.5 cm, bottom – 2.5 cm, top – 2.5 cm. No margins should be left for binding. The text throughout the paper should be justified (aligned evenly – you can use the keyboard shortcut: Ctrl+J). Paragraphs (indentations) should be made automatically with the tab key after setting a value of 0.63 cm (Indentation – First line).
The formatting of the text should involve automatic word division. The text of the thesis (abstract, introduction, chapters) is written in 12-point font, Times New Roman CE, with 1.5 line spacing.
The heading of the first chapter following the introduction should start on a new page. The header of each subsequent chapter should be put on a new page. The page header, in addition to the title page, includes:
•	on the even-numbered page: first name and surname (font 9 pt., centred)
•	on the odd-numbered side: the title of the work (font 9 pt., centred).
The page numbering starts with the “Summary section” and is at the bottom of the page, in the middle.
This template, included in the electronic version, presents a formatting style in line with these guidelines. The template may be modified in consultation with the thesis supervisor.






[bookmark: _Toc159999866]Introduction
In the thesis introduction, it is crucial to clearly and precisely state the main research problem or issue on which the thesis focuses. This introductory paragraph plays an extremely important role as it introduces the reader to the main topic of the thesis, delineating its scope and emphasising the scientific or practical significance of the issue studied. An essential element of the introduction is a sound justification for the choice of topic. The introduction should reflect the topicality and relevance of the problem in the context of the chosen scientific field and explain why the topic is worth investigating deeper. The rationale should also explain how the work contributes to developing existing knowledge in the field or solving specific practical problems. The objectives of the thesis should also be clearly stated, which can be both theoretical and practical. Theoretical objectives focus on extending and deepening existing scientific knowledge, while practical objectives aim to apply theory to solve specific problems or challenges. Clearly defining the objectives allows the reader to understand the scope of the thesis and its potential implications for theory and practice. The thesis is expected to demonstrate the student’s ability to analyse a problem in depth, the ability to think critically, gather and process information effectively, and the ability to draw logical conclusions and formulate understandable arguments. The dissertation will also assess the student’s ability to conduct research and to analyse and interpret the results in the context of existing literature and theory.
In the continuation of the thesis introduction, the chosen research methods used to analyse and solve the problem should be presented in detail. It is essential to describe the nature and types of sources used, such as scientific literature, empirical data or case studies, to emphasise the credibility and depth of the study. In addition, the structure of the thesis should be outlined, explaining how the individual chapters and sections contribute to the overall understanding of the topic under study, providing the reader with a guide to the critical elements of the thesis.





Chapter 1. [bookmark: _Toc159999867]Title of the chapter
[bookmark: _Toc159999868] Division of the work into chapters
In a thesis, it is essential to clearly divide the text into sections with headings, which facilitates understanding of structure and coherence. Dividing the text into chapters and subchapters helps to organise the content and to refer to the theory. The use of styles in the headings facilitates the creation of a table of contents.
It is recommended to use automatic numbering of headings, avoiding more than three levels of text division. As the primary logical unit of the text, each paragraph should clearly indicate a new thought. Paragraphs should be of appropriate length and aligned on both sides. The thesis should be written in formal language, without orthographic, grammatical, punctuation and stylistic errors. Quotations should be formatted according to the established rules. The text of the thesis should be divided into parts with headings (titles) to show a clear structure and coherence. Dividing the text into chapters and subchapters and titling them makes it easier to organise the content and refer to particular theories. The use of styles in the headings (titles) facilitates the creation of an automatic table of contents in the work.
In the empirical chapter of the thesis, the reader should find the research results presented in detail or a project section including specific recommendations. This chapter is where the student can present an original contribution, highlighting their achievements and observations, and should stand out for its unique character and reflect the diploma student’s individual approach to the topic.
[bookmark: _Toc159999869] Language requirements
The thesis recommends an impersonal narrative style, which translates into objectivity and formality in the presentation. Phrases such as “The thesis presents...” or “The author/author analyses...”, avoiding direct personal references (e.g. “In the paper I will present...” or “In my analysis...”). This writing style not only reinforces the objective nature of the paper, but also emphasises its formal and scientific tone.
An important aspect of the thesis is to ensure that the text is clear, logical and comprehensible. The text should be clear and communicative while at the same time containing precise and logically arranged arguments. Linguistic correctness is also crucial, as well as spelling, grammar, and style. The author should avoid jargon, slang expressions and colloquial language, focusing on a reliable and scientific writing style that best conveys the seriousness and scientific value of the work.
In the context of preparing a thesis, it is extremely important to maintain consequence in the use of grammatical tenses. Inconsistencies which may cause confusion and lower the formal level of the thesis must be avoided. For example, it is a linguistic error to mix up tenses in the description of chapters, as in the sentence: “In the second chapter we will show...” using the future tense, followed by: “In the third chapter we presented...” using the past tense.
It is recommended to avoid formulating content in the form of direct questions. Questions such as “Why?”, characteristic of journal articles, are not appropriate in a formal academic style. The thesis should be characterised by an objective and analytical approach, where all issues and problems are explored and resolved through systematic analysis and discussion, rather than by direct enquiry to the reader.
The importance of using up-to-date data and contemporary methodology in the thesis should also be emphasised. For example, relying on outdated data, such as the 2008 Human Development Index (HDI), does not reflect current trends and advances in the field under study. The timeliness of the data is crucial to ensure the credibility, relevance and scholarly value of the thesis, enabling it to present an accurate and actual picture of the topic under study.
[bookmark: _Toc159999870] Formatting the work
[bookmark: _Toc159999871]Table
When creating tables in the thesis text, certain rules should be followed. Each table should contain a precise title, including the word ‘Table’ and the number of the table, according to Arabic numbering. It is also important that the table has a properly designed layout and an indication of the source of the information. Tables, like figures, should be sized to fit the content, with the text in the table being no smaller than 10 pt. The space between the text and the table and the table caption should be one line. The table caption is placed above the table, aligned to the left, with appropriate font and formatting.
[bookmark: _Toc159917328]Table 1. Format of sample table
	Headline
	Headline
	Headline

	Text
	Text
	99,99

	Text
	Text
	9,99

	Text
	Text
	999,99


Source: own elaboration.

It is recommended that tables with figures (numbers) use Times New Roman font, size 10 pts, without indentation or spacing, and centred. Units of measurement (e.g. PLN, million USD, %) should not be placed next to figures but in the title of the table or row/column headings.
It is recommended that tables are created directly in a word processor such as Microsoft Word. This practice not only ensures aesthetic consistency throughout the document, but also allows tables to be easily edited and adapted to meet the formatting requirements of the work. The data for the tables may initially be prepared and analysed in Microsoft Excel or other data processing software and then imported into Word. It is important that this data is pasted in the form of editable tables rather than as static images, so that further modifications and adjustments can be made.
When preparing the thesis, particular attention should be paid to how figures are presented in tables. It is important that the figures in the table are presented with uniform accuracy, which ensures consistency and facilitates the interpretation of the data. Uniform accuracy refers to the consistent use of the same number of decimal places for all numerical values in a table, which is vital in ensuring precision and convenient comparability of data.
In addition, it is important that the whole table, including its title, mock-up, and source, be on one page of the document. Such a layout makes it easier for the reader to absorb the information and allows better orientation in the structure of the work. If a table is too long and does not fit on a single page, it is advisable to repeat the table heading on subsequent pages to make it easier for the reader to continue viewing the data. If changing the orientation of the pages from vertical to horizontal would make it easier to fit the whole table on one page, this should be considered. Each table should also be thoroughly discussed in the text of the paper. This discussion should include an interpretation of the data presented, pointing out its significance in the context of the issue under study and explaining any anomalies or trends visible in the data.
The use of automatic numbering of tables, figures and diagrams is also recommended. The numbering system significantly simplifies and speeds up the process of creating lists of tables, figures and charts. Automated numbering also ensures that each graphic element is properly identified and indexed throughout the document. To insert an automatic caption for a table, figure or chart, you can use the functions available in the “References” tab of most word processors. For example, in Microsoft Word this option is located under the “Insert Caption” button (see Figure 1).

	[image: ]
	[image: ]

	[bookmark: _Ref159313358][bookmark: _Ref159313348][bookmark: _Toc159917379]Figure 1. Automatic references to figures, tables and charts
Source: own elaboration.



Then, in the text, next to the description and commentary of the data and information presented in the table (figure and chart), a “Reference” should be automatically inserted (from the “References” tab), which will automatically renumber the text when the table (figure and chart) number is changed.
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	[bookmark: _Toc159917380]Figure 2. Automatic references to figures, tables and charts
Source: own elaboration.



Careful preparation and presentation of tables in a thesis is a crucial aspect that significantly affects the readability, professionalism and overall scientific quality of the document. Ensuring that the data presented in the tables are sufficiently accurate and consistent is essential to ensure accurate and effective communication of research results.
[bookmark: _Toc156648259][bookmark: _Toc156648260][bookmark: _Toc156648261][bookmark: _Toc159999872]Figures and charts
Figures in the thesis text should be placed according to specific rules. Each figure must include a precise title with the name ‘Figure’ and Arabic numbering, the relevant image and an indication of the source. It is recommended that figures do not begin or end chapters or subsections. Figures should be separated from the main text by blank lines. Continuous numbering of figures in the text is used, and the caption should be placed directly below the figure, centred and in 10 pt font. Figures should be appropriately sized and legible, and their placement in the text should be carefully considered with regard to orientation and legibility. A correctly inserted object is shown in Figure 3.
[image: LOGO_UMCS_S_szarosci_RGB]
[bookmark: _Ref155361411]
[bookmark: _Toc159917381]Figure 3. Example drawing
Source: own elaboration.

As with figures, graphs in the thesis must be legible and fit properly into the page format. Care should be taken to ensure that graphs are easy to interpret and do not exceed the established margins of the text. For large graphs, you may consider using a landscape page orientation. Any additional markings on charts, such as a legend or explanation of symbols, should be clearly described and placed in a way that makes them easy to understand. The formatting of the chart description should be consistent with the rest of the work, it is recommended to use Times New Roman font, size 10 pts, with single spacing, no indentation, centred. The final form of a correctly inserted object is shown in Diagram 1.


[bookmark: _Toc159330781]Diagram 1. Example diagram
Source: own elaboration. 

Where additional markings are included in the diagram, their explanation should be placed directly under the title of the figure, above the source. Formatting: font Times New Roman 10 pt, single line spacing, no indentation, space before 6 pt, centred.
As with tables, it is essential that graphs and figures, with their titles and sources, fit on one page of the thesis. Each graph and figure should also be described in detail in the text so that the reader can understand their use and relation to the topic under discussion. It is important that the visual elements are consistent with the content of the work and contribute to a better understanding of the research material presented.
The numbering of figures and diagrams should, as with the numbering of tables, be done automatically. To do this, use the “References” tab and select the “Insert Caption” (see Figure 1). If a label is missing (e.g. a figure or diagram), use the “New Label...” command in the “Signature” command (see Figure 4).

[image: ]
[bookmark: _Ref156645791][bookmark: _Toc159917382]Figure 4. Creating a new signature label
Source: own elaboration.


All graphical elements, such as figures and graphs, must be carefully integrated into the content of the thesis, which means that their placement should directly support and enrich the text. Not only do they make it possible to visualise the data and concepts described in the thesis, but they also play a key role in helping the reader understand complex issues and identify key conclusions. Therefore, their placement in the document and the choice of formatting should be carefully tailored to the context of the discussion so that each graphic element is a logical complement to the text and contributes to a deeper understanding and analysis of the research issues discussed. It is advisable to choose the appropriate type of graph depending on the data being pre-presented. For example, a pie chart may be used to show the structure of sales, exports and education. A 100% cumulative column chart is helpful to show changes in structure over time, and a cumulative column chart to show changes in value and structure over time. A column chart or a line chart can show the change in value over time. When comparing several countries or entities in several areas simultaneously, it is worth considering the use of a radar chart. It is also possible to use two types of chart on one – for some data, e.g. a column chart, and for other data, e.g. a line chart. A combo chart is used for this purpose. This chart is also useful when two axes are needed (one, for example, in USD million and the other in %).
[bookmark: _Toc159999873]Mathematical formulas
Mathematical formulae in the thesis play an important role in the clear presentation and solution of scientific problems. It is important that they are an integral part of the text, highlighted and clear to the reader. Each mathematical formula should be highlighted by being centred and separated from the rest of the text by a single line spacing. The numbering of formulas should be consistent and legible. The formula number is usually placed on the right-hand side near the page margin.
Formulas that are repeatedly used in the text should be referred to by reference to a number without being repeated. All symbols and variables in a formula must be unambiguously defined, and any non-standard or advanced formulae should be supported by references to the source literature. For longer formulas that do not fit on a single line, the writing should be kept aesthetically pleasing and clear, avoiding leaving symbols at the end of lines. When editing formulas, it is advisable to use a specialised equation editor, which ensures the correct format and readability. To do this, select the “Equation” command from the “Insert” tab (see Figure 5).

[image: ]
[bookmark: _Ref156646016][bookmark: _Toc159917383]Figure 5. Inserting mathematical formulas
Source: own elaboration.
	
When working on a document containing mathematical equations, it is particularly important to make changes to the prepared equations correctly and efficiently. To make any modifications or corrections, the user should use the “Design” tab, which becomes active when an equation is selected in a document. The “Design” tab in a word processor such as Microsoft Word offers a wide range of tools for fine-tuning equations – from changing the font and adding mathematical symbols to modifying the structure of the equation itself (see Figure 6). 
[image: ]
[bookmark: _Ref156646169][bookmark: _Toc159917384]Figure 6. Editing equations
Source: own elaboration.

It is important to keep the style and formatting consistent with the rest of the document when editing equations. This includes using the correct font size, style and layout of the equations to ensure that the work is legible and professional looking. Mathematical formulas can be presented in a two-column table with invisible borders, making them easier to centre. Care should also be taken to ensure that any changes are made in a way that does not disrupt the consistency and mathematical logic of the equations. The following are examples of mathematical equations.
	
		(1)


	
where:
 – vector of model parameters,
 – the expected value of the parameter vector ,
 – the expected value of the scalar product of the parameter vectors  and,
 – variance common to all parameters.

	
	(2)



		
where:
 – values of the independent variables for the 𝑖th observation,
 – regression coefficients for individual independent variables,
 – constant term, 
 – random error[footnoteRef:1]. [1:  Wooldridge, J. M. (2010). Econometric analysis of cross section and panel data. MIT Press.] 

[bookmark: _Toc159999874]Annexes
Appendices to the thesis may include a range of documents and materials that support its substantive content. These may include organisational, financial, additional documents, surveys (see Appendix 2), full survey results, extracts from texts, drawings, program codes (see Appendix 1), technical documentation of the systems, programming languages, tools and facilities used. They are important if they contribute to a deeper understanding of the topic of the thesis, offering the reader additional information that may be too detailed to include directly in the main text of the thesis. Appendices should be easily accessible and readable to enable readers to understand the research and arguments presented fully.
[bookmark: _Toc159999875]Scoring system
The adoption of a uniform scoring system in the thesis is an important element in maintaining the coherence and professionalism of the document. It is an expression of good academic practice, making it easier for the reader to navigate through the text and enhancing the aesthetics and readability of the thesis. The scoring system involves not only the selection of the appropriate point type (e.g. full stops, quatrefoils, dashes) but also their consistent application throughout the document. A consistent scoring system should be applied to all parts of the work where enumerations appear – from the main chapters and subchapters to the lists and lists in the appendices. Such consistency not only facilitates orientation in the text but also emphasises the author’s care and attention to detail.
In addition, it is worth paying attention to the correct formatting of the points, which should be consistent with the overall layout of the paper. Care should be taken to ensure that spacing between bullet points and text is consistent and that the size and type of font used for scoring is consistent with the rest of the document. Such a consistent scoring system not only contributes to the aesthetics of the paper but also to its professionalism and perception by the reader.
[bookmark: _Toc159999876]Use of heading styles
An important aspect of the thesis preparation is the use of consistent heading styles, which facilitates the organisation of the text and its subsequent formatting. Using predefined styles, such as “Heading 1”, “Heading 2”, allows automatic creation of a table of contents and makes it easier to navigate through the document.
The use of consistent heading styles improves the work’s aesthetics and demonstrates a professional approach to its preparation. By defining and applying different headings levels, the text becomes more readable while specific sections and subsections are clearly separated and hierarchically organised.
[image: ]
[bookmark: _Ref156763801][bookmark: _Toc159917385]Figure 7. Choosing the right header style
Source: own elaboration.

When formatting the thesis, it is recommended to use “Heading 1” for the main chapters, “Heading 2” for subsections and, for further subdivision, the use of successive levels of headings (see Figure 7). This approach not only makes it easier for the reader to follow the structure of the work but also enables the author to quickly make changes and updates to the document while maintaining consistency of formatting.
[bookmark: _Toc159999877] Examples of citation
The APA style for citations and bibliographic references should be followed for references in the thesis text. According to this style, the author and year of publication should be indicated directly next to the cited passage of text in brackets, for example (Kowalski, 2020). Full information about the source, including the work’s title, publisher and place of publication, is included in the bibliography section at the end of the paper. Using APA style, the reader can quickly locate and verify sources without having to stop reading the main text.
Paraphrasing in the thesis is the ability to interpret and present the thoughts of other authors in one’s own words while remaining faithful to the original message. This is crucial when we want to use someone else’s ideas while avoiding accusations of plagiarism. When paraphrasing, it is important to thoroughly understand and process the source content and then present it in a new form, reflecting its main idea but weaving in author’s own style and perspective. Paraphrases should also be cited appropriately, with clear reference to the source, to give credibility to the message and show where the adapted ideas come from.
Example:
Since the beginning of the 21st century, both Digital Marketing (DM) and Data Sciences (DS) have remarkably evolved in terms of use and profitability (Tiago & Veríssimo, 2014). This has led to the emergence of a digital ecosystem, which connects users 24/7 and which has shaped users’ new habits and behaviors (Mayer – Schönberger & Cukier, 2013).
DM is defined as a set of techniques developed on the Internet with to persuade users to buy a product or service (Avery, Steenburgh, Deighton, & Caravella, 2012). Today, the daily roadmap for companies that operate on the Internet includes techniques such as Search Engine Optimization (SEO), i.e. optimisation of search results from major search engines; Search Engine Marketing (SEM) or programmatic advertising, i.e. strategies to sponsor ads in search engines or in advertising space on banners in websites; as well as Social Media Marketing (SMM), i.e. strategies of interacting with users on social networks through social ads (Lies, 2019, Palos – Sanchez et al., 2019).
In recent years, DM has spurred a considerable research interest among scholars (Kannan, 2017). For instance, Rogers and Sexton (2012) sought to understand the key ways to improve profitability or ROI (Return of Investment) in DM. Furthermore, Kumar et al. (2013) measured the influence of data on the DM ecosystem. Likewise, Saura, Palos – Sánchez, and Cerdá Suárez (2017) identified the metrics to measure the efficiency of each of the DM actions developed by a company on the Internet.
[bookmark: _Toc159999878]Bibliography
In the conclusion of the thesis, it is important to include detailed biographical information on all sources used. The bibliography should be prepared alphabetically under the heading “Bibliography”, following the APA citation style. For efficient collection and formatting of bibliographic data, programs such as ZOTERO or EndNote can help compile bibliographies by automating the retrieval of data from various sources and formatting them accordingly.
The bibliography of the thesis should include only those sources that have been used, such as books, textbooks and journal articles. Both Polish and English (or, more broadly, foreign-language) items should be included to provide an international context for the study.
References to a particular item of literature may occur more than once in the text, but each item should be listed only once in the bibliography. Authors should be arranged alphabetically. One selected APA citation style should be used consistently in the bibliography. APA (American Psychological Association) style is a widely used way of formatting scientific papers, particularly in the social sciences. It is characterised by specific guidelines on text formatting, page layout, in-text citations and the bibliography’s structure. This is important for the clarity and uniformity of the paper. A sample bibliography, formatted according to APA style guidelines, can be found at the end of this document in the dedicated “Bibliography” section. It is a model example that demonstrates how to format individual entries, taking into account elements such as author names, year of publication, title of the work, place of publication and the name of the publishing house.
Bibliography management programmes such as ZOTERO allow automatically converting bibliographic items to various citation styles, including the popular APA style. Users can easily import bibliographic data from digital sources and then format it according to the selected standards, greatly simplifying creating a bibliography.
[bookmark: _Toc159999879] Directory of legislation
In the index of legal acts appended to the thesis, an order that reflects the legal hierarchy and the chronology should be adopted. Priority is given to arranging the acts according to their rank – at the top there are the documents with the highest degree of importance, such as the Constitution, which is the foundation of a country’s legal system. This is followed by statutes, which are the basic normative acts issued by parliament and define the principles of the functioning of the state and society.
After acts of a nationwide nature, such as the Constitution and statutes, there are lower-order acts, which include, inter alia, regulations issued by executive bodies to regulate in detail matters already regulated by statutes. Next in line are ordinances and other acts of local or sectoral law which apply to specific areas or professional groups. Within each category, documents should be ordered chronologically, meaning that the first are acts issued earlier. Such an order makes it easier to understand the legal evolution in a given field and enables the reader to find the information of interest quickly.
It is important to provide complete and precise bibliographical details with each entry, such as the full name of the legislation, its date, and source of publication (official journal). Such an approach not only demonstrates the scientific integrity of the work but also enables the reader to verify and further search for sources.
[bookmark: _Toc159999880] Internet sources
When citing online sources, it is important to include the name of the site or its owner so that the credibility of the material can be assessed. One should also include the correct web address and the date one visited the site. For example: “According to information published on the website of the Polish Central Statistical Office (www.stat.gov.pl, accessed 20.03.2023), economic growth...”.
Use legal sources, such as the Legal Sources Database [http://legalnakultura.pl/en/legal – sources], and always document the source of any photograph or illustration used.
[bookmark: _Toc159999881] Use of illustrations and photographs in the thesis
[bookmark: _Toc159999882]Copyright protection
Illustrations and photographs constituting a manifestation of creative activity of a human being of an individual character, established in any form, regardless of value, purpose and manner of expression, are works subject to legal protection (art. 1 of the Uniform Partnership Act –
UPA). The general legal principle is that it is the author who is solely entitled (art. 8 of the UPA) to the work as regards moral rights (art. 16 of the UPA – protection of personal relations with the work, e.g. through the right to mark oneself as the author or the prohibition on infringing the content and form of the work) and economic copyrights (art. 17 of the UPA – all rights to exploit the work in any manner whatsoever). Thus, any form of exploitation of someone else’s work requires – as a rule – the acquisition of rights by means of a contract transferring rights or a licence agreement authorising the use of rights to the work.

[bookmark: _Toc159999883]Consent of the creator when using images from the Internet
Images and graphics created by authors and made available on the Internet are protected by law. The general principles of copyright law are approximated globally due to international agreements standardising the principles of protection. Thus, whenever photographs downloaded from the Internet are used in the thesis, the consent of the copyright holder must be obtained unless such use without the need to obtain such consent is possible under the so-called statutory licences – resulting from the provisions of the copyright law or in the case of distribution of the work by the author under the terms of licences allowing its use without such consent (e.g. Creative Commons).

[bookmark: _Toc159999884]Statutory licences
Exceptions to the principles of copyright protection are the so-called statutory licences, which are strictly defined in the regulations cases and allow legal use of materials without the author’s consent. The most significant statutory license for using works in diploma theses is the “right of the quotation” under Article 29 of the Copyright Act, which allows quotations from minor works in their entirety or from distributed plastic or photographic works in fragments in works that form an independent whole, as long as the quotation serves a purpose that is justified by the use of the quote, such as teaching, polemic, critical or scientific analysis, explanation, or the work’s genre. The condition for the legal use of a work under a statutory licence – including the right of quotation – is to comply with the content of Articles 34 and 35 of the UPA, which provide that:
· Works may be used within the limits of fair use provided that the name of the author and the source are mentioned. The mention of the author and the source should take into account the existing possibilities.
· The authorised use must not infringe the normal use of the work or harm the legitimate interests of the author.
[bookmark: _Toc159999885]Creative Commons and free licensing terms
Creative Commons–type licences allow the use of protected material without the need to obtain additional permission from the creator, provided that certain licence conditions are respected. One of the fundamental requirements is the acknowledgement of authorship of the work. Below is a detailed summary of the different types of Creative Commons licences, based on information from the Polish version of the Creative Commons website:
· Attribution 3.0 Poland: This licence entitles you to copy, modify, distribute, display and perform the work, provided that the author is clearly credited. It is one of the licences offering the broadest freedoms to the user.
· Attribution – ShareAlike 3.0 Poland: This licence allows you to copy, modify, distribute, display and perform the work, but all dependent works must be made available under the same licence terms. This is the licensing model used by Wikipedia and its sister projects.
· Attribution – Noncommercial 3.0: This license permits you to copy, modify, remix, distribute, display and perform the work solely for non-commercial purposes. However, this condition does not extend to derivative works, which may be subject to other licences.
· Attribution – No Derivative Works 3.0 Poland: This licence permits the distribution, presentation and performance of the work for both commercial and non-commercial purposes, provided the work remains in its original form and is not modified to create derivative works.
· Attribution – Non-commercial use – Under the same conditions as 3.0 Poland: This licence authorises the distribution, presentation and performance of the work for non-commercial purposes only, with any derivative works to be made available under the same licence conditions.
· Attribution – Noncommercial – No Derivative Works 3.0 Poland: This is a licence that allows you to distribute, display and perform a work for non-commercial purposes only and on the condition that the original work is preserved, without creating derivative works. It is the most restrictive of the Creative Commons licenses.
Important licensing restrictions therefore include acknowledgement of authorship, a prohibition on the creation of derivative works and the obligation to apply the same licensing terms for further use and distribution.
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	Data <– c(10, 20, 15, 25, 30)

# Calculating the average mean <– mean(data)

# Calculation of standard deviation deviation_std <– sd(data)

# Calculation of coefficient of variation coefficient of variation < – (deviation_std / mean) * 100

# Displaying the result
print(paste("The coefficient of variation is:", coefficient_variability, "%"))
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	1. How often do you use the services of the Authority?
 at least once a month   several times a year   first time
2. What was the reason for your visit to the Office?
 downloading forms   submission of application, notification or letter   completion of documentation   obtaining information   other (which?)
……………………………………………………………………….................
……………………………………………………………………………………………………………………………………………
3. Did you find the right employee without any problems?
 yes   no
4. In which organisational unit of the Office did you handle the case?
……………………………………………………………………………………………………………………………….…………
5. Please evaluate our service against the following criteria: 
a) processing time 
 short   medium   long   very long
b) employee competence and expertise 
 very good   good   satisfactory    bad
c) courtesy, kindness and care for the customer
 very good   good   satisfactory    bad 
d) waiting time for acceptance by the official 
 short   medium   long   very long
e) assistance in completing documents
 very good   good   satisfactory    bad   did not receive any help
6. Have you dealt with the matter with which you came to the Office?
 yes   rather yes   no

7. Is the manner in which the Authority provides its services and the extent to which information regarding the case is in line with your requirements? 
 yes   rather yes   no
8. Do your opening hours suit you?
 yes   rather yes   no   other (which?) …………….…………………………………………………………...
……………………………………….…………………………………………………………………………………………………….
9. Do you see a need to make a telephone/electronic appointment at the Office in advance?
 yes   rather yes   no
10. Which contact method with the Office is most convenient for you?
 in person   by telephone   letter   electronic
11. What difficulties did you encounter in dealing with the case?
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………
12. Do you consider the Office to be a “friendly” institution for residents?
 yes   rather yes   no
13. Did you like the venue and its signage?
 yes   no
14. Did you use the service description sheets available to you in dealing with the case on the website?
 yes   no
15. Are you satisfied with the location of the Office building, the possibility of parking and access to the office?
 yes   rather yes   no
16. How do you obtain information about the Authority?
 telephone information   from information boards   from the Authority’s website  
 other (e.g. from friends, family)
17. In your opinion, what changes could improve the quality of services provided at the Office?
………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………………

Metrics
The information provided below will allow a better analysis of the survey results. 

	Gender:
· Woman
· Male
	Age
· Up to 25 years
· 25 – 35 years
· 35 – 55 years
· 55 – 65 years
· over 65

	Education
· basic
· professional
· Medium
· higher
	Professional 
status
· pupil/student
· working
· not working
· pensioner




Thank you for completing the survey.
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